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Support for EndNote Version X2 
March 2009 

The University of Newcastle has upgraded to EndNote Version X2.  EndNote X2 is the version currently 
supported by the University of Newcastle in its training program, online and library support services. 

Should you upgrade to Version X2? 

You should upgrade if: You should NOT upgrade if: 
¶ You are a student who uses EndNote on 

campus in the labs or libraries and at 
home on your personal computer 

¶ You will be sharing your EndNote Library 
with other EndNote X, X1 or X2 users 

¶ You are a Macintosh user and work with 
MS Word 2004 or 2008 

¶ You are a Macintosh user and your 
operating system is Macintosh OS X 
version 10.4.x - 10.5.x  

¶ You need Unicode characters for Chinese, 
Japanese or Russian. 

¶ You wish to use new features of EndNote 
X2 such as Smart Groups. New features of 
EndNote X2 will be ignored by earlier 
versions. 

¶ You will be sharing EndNote Libraries with 
others who are using EndNote 7 or earlier 
versions 

¶ You are a PC user with MS Word pre 2003 

¶ You are a Macintosh user with MS Word 
2001 or earlier 

 

 

Version X2: Software and Hardware Requirements 
 

Platform Hardware Word Processor Compatibility 

 

¶ Windows XP (Service Pack 2) or 
Windows Vista 

¶ Pentium 450 megahertz (MHz) or 
faster 

¶ At least 256MB RAM 

¶ At least 180 MB of free hard disk 
space  

In order for Cite While You Write commands to 
install properly: 

¶ Microsoft Word 2003 or 2007 

¶ Other word processors see Chapter 2 of 
the EndNote manual. 

Note: EndNote X2 files are compatible across Windows and Mac OS X platforms 

 

¶ Macintosh OS X version 10.4.x ς 
10.5.x 

¶ PowerPC or Intel Macintosh 450MHz 
or higher with 180MB available  

¶ Minimum of 256MB available RAM  

In order for Cite While You Write to install 
properly Microsoft Word X, 2004 or 2008 

For more information see the EndNote 
support site 
http://www.endnote.com/ENMac.asp 

http://www.endnote.com/ENMac.asp
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Backward Compatibility 

EndNote Version X2 is not backwardly compatible with EndNote Version 7 (or earlier versions). This 
means that libraries, output styles, filters and connection files created in Version X2 cannot be used in 
Version 7. 
 
NOTE: You can open and use libraries created with EndNote 7, 8 and 9 in EndNote X2, however once you 
have done this you can only use the library with EndNote X or later. 
 
Therefore, if you use EndNote on University Lab and Library computers as well as at home and you have 
Version 7 (or earlier), 8 or 9 installed at home, it would be advisable for you to upgrade. 

 

Q: Can EndNote libraries created with Version 7, 8 or 9 be converted to Version X2? 
A: Yes, you can convert libraries created with Versions 7, 8 or 9 to be used with EndNote X2. 
However, you cannot convert a library back to Version 7 (or earlier), 8 or 9 without encountering 
considerable difficulties.  

 

Before Upgrading 

¶ Back up your Files ς including your EndNote Libraries, personalised output styles, filters and 
connection files. These can be copied back into the new EndNote folders (ie. Styles, Filters, 
Connections) once you have installed EndNote X2. Please check the University of Newcastle 
EndNote Support website to check if the filter/style/connection has been updated.  

Upgraded Filters -  
www.newcastle.edu.au/library/endnote/filters.html 

Upgraded Styles -  
www.newcastle.edu.au/library/endnote/styles.html 

Upgraded Connection Files - www.newcastle.edu.au/library/endnote/connect.html 

¶ Unformat Your Documents ς within MS Word, select the Unformat Citations icon.  References 
will change to the unformatted state, eg. {Smith, 2006 #123} 

¶ Uninstall any Earlier Versions of EndNote ς select Add or Remove Programs from the Control 
Panel  

Further considerations before upgrading 

¶ If a document which has been formatted with EndNote X2 is later formatted with an earlier 
version of EndNote, all references will be deleted. 

¶ If you decide after loading Version X2 that you wish to revert back to a version of EndNote 
earlier than X, you will encounter considerable difficulties. 

¶ Output styles created in Version X2 cannot be used in Version 7 and earlier. 

¶ Do not run 2 versions of EndNote (ie. EndNote X2 and EndNote 7 on your computer.) 

http://www.newcastle.edu.au/library/endnote/filters.html
http://www.newcastle.edu.au/library/endnote/styles.html
http://www.newcastle.edu.au/library/endnote/connect.html
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Obtaining EndNote 
 
¶ Download EndNote X2 from the University's EndNote download site 

www.newcastle.edu.au/unit/it/endnote  
Access to this site is limited to University staff and students only - use your Internet username 
and password for authentication. Note that the files are very large and may take over 90 
minutes to download via a modem connection. Alternately you can come on campus and 
download the files to an external storage device such as a USB drive, CDRom or external hard 
drive. 

 

¶ Borrow a copy of the software on CDROM (Version X2 only) for installation on home computers 
from any University of Newcastle Library. Check NEWCAT (Title search for "endnote x2") for 
availability. Loans are strictly for 3 days only. A signed and completed copy of the Home Use 
Agreement for EndNote must be handed to Loans Desk staff when borrowing. 

 

¶ For on-campus installation, log a call with 492 17000 or 17000@newcastle.edu.au  
 

Installation Issues 

Two issues to be aware of during installation: 
 

1. ¢ƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ŦƛƭŜǎ ŀǾŀƛƭŀōƭŜ ŦƻǊ ŘƻǿƴƭƻŀŘ Ǿƛŀ ǘƘŜ ¦ƴƛǾŜǊǎƛǘȅΩǎ 5ƻǿƴƭƻŀŘ ǎƛǘŜ ŀǊŜ ƛƴŎƭǳŘŜŘ ƛƴ ŀ 
zipped folder. This folder  MUST be unzipped ς the easiest way to do this is: 

¶ Right click on the zipped folder, then select Extract All Χ  

¶ This will create an unzipped version of the folder, with the same folder r name ς open 
this folder then double click the ENX2Inst.msi file. 
 

2. Word 2007 users - during the installation a message will confirm if EndNote is to be the 
preferred reference creator ς select Yes. 

 
There have also been some reports on campus of the EndNote toolbar missing in Word 2007. To correct: 

¶ Click Start | Run 

¶ Type gpupdate /force (there is a 
space before the slash). The screen at 
right will appear 

¶ Type Y then enter 
 
The computer will restart and the problem 
corrected. Thƛǎ ƛǎ ŀ ǉǳƛŎƪ ǎƻƭǳǘƛƻƴ ŀǎ ƛǘ ŘƻŜǎƴΩǘ 
bring down any of the group policies ς it just 
updates the PC. 
 
Typing N will remove the dialog box, and exit 
from it without updating the PC. 

 

http://www.newcastle.edu.au/unit/it/endnote
http://www.newcastle.edu.au/services/library/about/hours/index.html
http://library.newcastle.edu.au/
http://www.newcastle.edu.au/service/library/endnote/guides/HomeUseAgreementforEndNote.pdf
http://www.newcastle.edu.au/service/library/endnote/guides/HomeUseAgreementforEndNote.pdf
http://www.newcastle.edu.au/service/library/endnote/guides/HomeUseAgreementforEndNote.pdf
mailto:17000@newcastle.edu.au
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New Features in EndNote X2 

Changes to the Library and Reference Windows 

 

 

 

Library Window 
1. Library Search Modes display (see below for detail) 
2. New reference icon 
3. hƴƭƛƴŜ {ŜŀǊŎƘ ƛŎƻƴ ό/ŀǳǘƛƻƴΥ ŦŀƳƛƭƛŀǊƛǎŜ ȅƻǳǊǎŜƭŦ ǿƛǘƘ 9ƴŘbƻǘŜ ·нΩǎ ƴŜǿ ǎŜŀǊŎƘ ƳƻŘŜǎ ŀƴŘ 

groups feature before using) 
4. Import and Export icons 
5. Find Full Text (Not working at present due to proxy issues) 
6. Open Link (opens URL of selected reference ς off-campus users may experience problems 

with journal articles from databases) 
7. Open File (opens any files attached to selected reference)  
8. Cite While You Write icons (only visible when Word is open) 
9. Help icon ς opens Help screen 
10. Quick Search tool (enter keyword to search your references) 

 

Library Search Modes 

The Library Window now displays 3 new icons which features library and online search modes.  

 

   
 
 
 
 
Users of previous EndNote versions, who choose to search library catalogues and databases via Endnote 
ƛƴǎǘŜŀŘ ƻŦ Ǿƛŀ ŜŀŎƘ ƛƴŘƛǾƛŘǳŀƭ ǎȅǎǘŜƳΣ ǿƛƭƭ ƴƻǘƛŎŜ ŀ ǎƛƎƴƛŦƛŎŀƴǘ ŎƘŀƴƎŜ ǘƻ 9ƴŘbƻǘŜΩǎ ǊŜǘǊƛŜǾŀƭ ŀƴŘ ŘƛǎǇƭŀȅ 
of references which may cause confusion. The Library Search Modes are designed  to be used in 
ŎƻƴƧǳƴŎǘƛƻƴ ǿƛǘƘ 9ƴŘbƻǘŜΩǎ ƴŜǿ DǊƻǳǇǎ ŦǳƴŎǘƛƻƴŀƭƛǘȅΦ  
 

You need to be aware when using the ΨIntegrated Library and Online SearchΩ mode that ALL retrieved 
references will be downloaded directly INTO your EndNote Library.  Use the Online Search mode which 
will download your references into a temporary window enabling you to select which references you 
wish to keep. 

2 
1 

3 4 
5 

6 
7 

8 

9 

10 

Integrated Library and 

Online Search ï Opens by 
Default  

(Not Recommended) 

Online Search 
(Recommended) 

Local Library 
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Integrated Library and Online Search Mode  ï Use with Caution   

This mode displays your online and local groups together in the Groups pane. If you use the 
Online Search option (ie. Search library catalogues and databases via EndNote) ALL results will be 
automatically downloaded into your EndNote Library. Previous versions of EndNote displayed results in 
a temporary screen. The temporary results screen is available by using the Online Search Mode. 

 

Local Library Mode  

9ƴŘbƻǘŜΩǎ [ƻŎŀƭ [ƛōǊŀǊȅ aƻŘŜ ŘƛǎǇƭŀȅǎ ŀƭƭ ƎǊƻǳǇǎ ŎƻƴǘŀƛƴƛƴƎ ǊŜŦŜǊŜƴŎŜǎ ǿƛǘƘƛƴ ȅƻǳǊ 9ƴŘbƻǘŜ [ƛōǊŀǊȅ ŀƴŘ 
hides all online groups. Use the Local Library Mode if you do not wish to see the Online Search options 
in the Group Pane.  

 
 

Online Search Mode  -  Recommended  

EndNote opens with the Integrated Library and Online Search option by default. Click on the Globe icon 
to open the Online Search mode. Once you have changed this, EndNote will remember this choice and 
open in Online mode the next time you open EndNote. 
 
Example using Newcat: University of Newcastle Library Catalogue 
 

1. Click Online Search in the EndNote Menu  
 

2. Scroll through the Connection File List and select U Newcastle Aust 
3. The Search pane will display at the bottom of EndNote 
4. Enter your search 
5. Select the number of references you want to display or click OK to display All References 
6. EndNote will display your selected references in a Temporary Database, separate from your 

EndNote Library, but displayed as a normal EndNote Library window. You must now add the 
references you wish to retain into your EndNote Library. You can move selected references by 
clicking on the reference (use CTRL key to select multiple references), right click with your 
mouse and select Copy References To | Select your Library 

 
!ƭǘŜǊƴŀǘƛǾŜƭȅΣ ȅƻǳ Ŏŀƴ ǳǎŜ 9ƴŘbƻǘŜΩǎ ƴŜǿ Groups feature to copy references into your Custom Group 
using Add References To | Select your Custom Group.  
 
Note: You must set up your Custom Groups before you begin searching.  
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Discard Duplicates (Online Search 
only) 

You can now direct EndNote to automatically 
discard duplicate references retrieved as part of 
an online search. 
 
From the EndNote Menu, select Edit | 
Preferences | Duplicates  
 
Check the box Automatically discard duplicates 
 

 

New Reference Types  

EndNote X2 now includes the following new Reference Types: 
 

¶ Aggregated database 

¶ Blog 

¶ Catalog 

¶ Equation 

¶ Pamphlet 

¶ Serial 

¶ Standard 

 

Groups Pane 

Groups is a feature in EndNote that allows you to store and organise your references into customized 
groups or subsets of your EndNote Library. EndNote X2 has introduced a new Groups Pane that displays 
by default in your EndNote Library Window as well as 2 new group types, Smart Groups and Online 
Search Groups. 
 
To hide the Groups Pane click on Groups | Hide Groups. 
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Custom Groups   

Custom groups allow you to create customised groups of 
references. 

 
Create a Custom Group 
To create a custom group: 

¶ Select Groups | Create Group from the EndNote 
menu bar, or alternatively, place your cursor over 
Custom Groups in the Groups Panel, right click then 
select Create Group. Name your group and press 
<Enter> to save your custom group. This will now 
appear in the Custom Groups list. 

 

 

Custom Groups 
Create your own groups of 

references by subject area or 
course code 

Smart Groups 
Create groups with a search 

strategy that will automatically 
update when you add and edit 

references 

Online Search Groups 
Displays database/library 

catalogue search results for 
online searches.  

Caution: Use only with Online 
Search Mode see p. 7 

Displays EndNote Web 
references (must be configured) 

Temporary Groups 
Includes All References, Search 
Results, Imported References, 

and Trash 
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Add References to Custom Groups 
To add references to custom groups: 

¶ Highlight the reference in the Library window and drag the reference to the specific custom 
groups. Alternatively, highlight the reference in the Library Window, right click and select Add 
references to | Create Custom Group and select the specific custom group. 

 
Deleting Custom Groups and References from Custom Groups 
To delete a custom group: 

¶ Select the group, then click on Groups | Delete group, or alternatively place your cursor over 

the custom group you wish to remove in the groups panel, right click then select Delete Group.  
 

Note: This will only delete the custom group, not the references within the deleted custom 
group. 

 

Smart Groups  

Smart groups enable you to set up a custom search strategy that searches for particular information in a 
specific reference field/s. Then, any references added to the library which include this information will 
automatically be added to that smart group. 
 

Create a Smart Group 
To create a smart group: 

¶ Click on Groups |  Create Smart Group, or alternatively position your cursor over Smart Groups 
in the Groups Panel, right click then select Create Smart Group.  

 
 

 
 
 
 
 
 
 

Create your search strategy using Boolean operators And, Or, and Not. 9ƎΦ YŜȅǿƻǊŘǎ Ŏƻƴǘŀƛƴǎ άŦƻǎǎƛƭέ 
!ƴŘ YŜȅǿƻǊŘǎ Ŏƻƴǘŀƛƴǎ άǇŀƭŜƻƴǘƻƭƻƎȅέ ǿƛƭƭ ǎŀǾŜ ŀƭƭ ǊŜŦŜǊŜƴces containing those keywords to your smart 
group. 

 
Naming your Smart Group 
From the Groups menu, choose Rename Group and type a descriptive 
name for the group. 
 
Deleting Smart Groups and References from Smart Groups 
To delete a smart group: 
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¶ Click on the name of your Smart Group and select Groups | Delete group, or alternatively, put 
cursor over the smart group you wish to remove in the Groups Panel, right click then select 
Delete group.  

 

Note: This will only delete the smart group, not the references within the deleted group. 

Change a Smart Group Search Strategy 
To change search strategy in Smart group, which will change the references added to the group: 

¶ Click on Groups | Edit GroupΧ Alternatively put the cursor over the smart group you wish to 
edit in the Groups Panel right click then select Edit GroupΧ 

 

Trash Group  

To delete unwanted references in your EndNote Library, click on the reference and select References | 
Move References to Trash. Alternatively, right click on the reference and select Move References to 
Trash. 
 
Deleted references will initially be moved to the Trash Group. To remove references completely from 
your EndNote Library: 

¶ Click References | Empty Trash or right click on the Trash Group and click on Empty Trash.  

¶ Select OK to confirm.  
 
You can also simply close your EndNote Library and you will be prompted to empty the Trash. 

 
Restoring Deleted References 
Until you empty the Trash, you can still drag references from the Trash group back to the All References 
group of your EndNote library. Alternatively, highlight a reference in the Trash group, right click on the 
reference, and choose Restore to Library. 

 
 
 
 
 
 
 
 

NOTE: Once references are removed from Trash they cannot be retrieved again. 
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Search Tab 

 
EndNote X2 includes a new 
method  to search for 
references: 

¶ Click on the Search 
tab featured in the 
Tab Pane of the 
Library Window (or 
click Tools |  Search 
Library). Alternatively, 
use keyboard short 
cut (Ctrl+F). 

¶ Alternatively type 
your search in the 
Quick Search box in 
the EndNote X2 
toolbar  

 

 
 
 
Search results are shown as a separate group in the Groups Pane.   
 

 
 
 

Quick 
Search Box 
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Folder Locations 

In EndNote X2 the location of the Styles, Filters and Connections folders has changed. To check where 
these folders are located on your computer, open EndNote and select Edit|Preferences|, then Folder 
Locations. 
 
File Path  - Windows XP 
C:\Documents and Settings\ [UserName]\My 
Documents\EndNote 
 
File Path  - Windows Vista 
C:\Users\ [UserName]\Documents\EndNote 

 
You must save all new or modified styles, 
connection files or filters to these personal 
folders. 
If you are upgrading from a previous version 
of EndNote, you may need to restore the 
Folder Location defaults. Select 
Edit|Preferences|Folder Locations and then 
click on the EndNote Defaults button. 
 

 

When downloading or modifying any styles, filters or connection files, save them in these personal 
folders. 

 

NOTE: EndNote can use custom styles, connection files and filters that have been created with EndNote 
versions 4 and later. Once you edit and save one of these files with EndNote X2, they are converted to 
the latest format which can be used from EndNote version 8 ς X2. 

 

Direct Export (from databases into EndNote) 

When using Direct Export from databases, EndNote now assumes that you wish to import selected 
references from databases into the EndNote Library that is currently open. If you do not have an 
EndNote Library open, you will be prompted to select an EndNote Library. 

Menu Functions 

The following functions have moved from the References menu to the Tools menu: 

¶ Search Library 

¶ Sort Library 

¶ Change and Move Fields 
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Date Stamping 

It is now possible to view the dates when references were added and last updated in an EndNote X2 
Library. This is featured in the footer of the reference. References created in versions Endnote X1 or 
ŜŀǊƭƛŜǊ ǿƛƭƭ ƻƴƭȅ ŘƛǎǇƭŀȅ ǘƘŜ ά[ŀǎǘ ¦ǇŘŀǘŜŘέ ŦƛŜƭŘ. 
 

Library Summary 

To retrieve basic information about your EndNote 
Library click on Tools |Library Summary.  
¢Ƙƛǎ ƛǎ ǳǎŜŦǳƭ ƛŦ ȅƻǳ ŘƻƴΩǘ ƪƴƻǿ ǿƘŜǊŜ ȅƻǳǊ 
EndNote Library is saved on your computer. 

 

 
 
 

Record Summary 

Information about individual references can be 
retrieved by highlighting a reference in the 
Library window, then clicking on References | 
Record Summary. Alternatively highlight and 
right click on the reference and select Record 
{ǳƳƳŀǊȅΧ 
This is useful to see what group(s) your 
reference is stored in. 
 

 
 
  

Shows the location of 
your EndNote Library 

on your computer 
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Display all Authors in 
Library Window 

In EndNote X1 and X2 there is the 
option to displaying all the authors in 
the library window by clicking on Edit 
| PreferencesΧΣ then click on Display 
Fields. 

 

 
 
All authors can be displayed by clicking the box next to Display all authors in the Author field then 
clicking OK. The fields will then display in the Library window. 
 

 
 

 

Send Compressed Files by Email 

To save a compressed library and then send it in 
an email 

 

¶ Select File |  Compressed Library (.enlx) > 
Create & Email  save to an Endnote 
Compressed Library (filename.enlx) 

¶ EndNote X2 then opens your default email 
program, creates a new email then attaches 
the compressed library to the email 

Add the additional information to the email and 
select Send  
 

NOTE: This function will only work if your email client is setup on the computer. 
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Cite While You Write Commands (Word 2007) 

EndNote X1 and EndNote X2 is compatible with Word 2007. Several EndNote commands appear in Word 
2007 (In Word, click on the EndNote tab from the toolbar). 

  
 

 

Remove Field Codes Function Renamed 

In Word 2007, this function is now renamed Convert to Plain Text 

 

 

 

 

 

 

 

 

 

 

 

 

 

Known problems in Endnote X2 (February 2009) 
User Testing at the University of Newcastle found the following issues:  

 

Find Full Text 

At present, the Find Full Text feature does not work on-campus. The problem appears to be related to 
our use of a proxy server which authenticates access to external sites.  Find Full Text has been tested 
off-campus and was successful in downloading some full-text documents.  

The University of Queensland Library1 lists the following factors which will assist in the retrieval of full 
text documents: 

¶ Link to PubMed Record: If you have downloaded the references using the PubMed connection 
file, they will have links in the URL field which connect to the PubMed record on the web. 

                                                
1
 University of Queensland Library. (2009). WhatΩs new in EndNote X2? Date accessed 20

th
 February 2009 from 

http://www.library.uq.edu.au/faqs/endnote/new_in_endnoteX2.html#4  

http://www.library.uq.edu.au/faqs/endnote/new_in_endnoteX2.html#4
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EndNote can make use of the LinkOut links from PubMed to locate full text of articles. Or if you 
have downloaded references from PubMed with a filter which imports the PubMed ID into the 
Accession Number field in EndNote, this can also be used to connect back to PubMed and use 
the LinkOut links to locate full text.  
 

¶ Digital Object Identifier (DOI): If the record has a correct digital object identifier in the DOI field, 
EndNote can use that to locate full text of articles.  
 

¶ Go to ISI link: If you have exported the references from the Web of Knowledge databases, they 
will have links in the URL field which connect to the Web of Knowledge record on the web. 
EndNote can make use of the Full Text links in Web of Knowledge to locate the full text of 
articles.  
 

¶ EndNote Web: Using EndNote Web in conjunction with EndNote will aid in full text retrieval. 
Note that you should enter your EndNote Web username and password in the EndNote 
Preferences. The presence of an international standard serial number in the ISSN field of the 
EndNote reference plays an important role here.  
 

¶ OpenURL: We are told that you must Enable OpenURL to use the Find Full Text function. To do 
this, click on Edit>Preferences and select URLs & Links. It is not clear how the Find Full Text 
function makes use of the OpenURL Link function, which has been available since EndNote 7. 
The OpenURL Link command is likely to retrieve a higher proportion of articles than the Find Full 
Text command, but it can only be used for one article at a time, and you must manually save the 
retrieved PDF and attach it to the reference. OpenURL Link works best if your library has 
implemented a link resolver. You should enter the details of the link resolver in the URLs & Links 
section of the EndNote Preferences. Otherwise you must use a generic link resolver, such as the 
one supplied in the EndNote default settings.  
 

¶ Internet Explorer 7: We are told that Windows users will get better results if they are using 
Internet Explorer version 7.  


